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Chapter 1: Introduction 
 

This section contains the following topics: 

Overview (see page 9) 
CA Clarity Requirements and CA Clarity PPM (see page 9) 
Audience (see page 10) 
Log in to CA Clarity Requirements (see page 11) 

 

Overview 

CA Clarity Requirements lets you manage requirements for projects, services, products, 
releases, and features. Using CA Clarity Requirements, you can trace a requirement 
from its original requester to its inclusion in a particular feature or release for a product. 
You can include detailed information about the requirement, its benefits, the source of 
the requirement, competing products, and ranking information. Associating these types 
of information with requirements can help you decide whether to include a requirement 
in a product release. 

 

You can also associate requirements with CA Clarity Agile™ user stories, from scrum 
methodology, to track the history of a user story for any given sprint. You can see the 
requirement that is associated with the user story and the source that requested the 
requirement. 

 

CA Clarity Requirements and CA Clarity PPM 

When CA Clarity Requirements is integrated with CA Clarity PPM, the following tasks can 
be accomplished: 

■ Role hierarchies can be downloaded from CA Clarity PPM to CA Clarity 
Requirements.  

■ A CA Clarity Requirements requirement can be linked with a CA Clarity PPM task 
from CA Clarity PPM. 

An administrator, with appropriate privileges in CA Clarity Requirements and CA Clarity 
PPM, performs these tasks. 

 

When integration is completed, the requirements and tasks are linked. The users can 
then see cost and effort information from CA Clarity PPM. The following information is 
available: 

■ Planned Cost 

■ Actual Cost 
 



Audience 
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■ Planned vs Actual Cost 

■ Planned Effort 
 

■ Actual effort 
 

■ Effort Remaining 

■ Planned vs Actual Effort 

Note: For more information about using CA Clarity Requirements with CA Clarity PPM, 
see the Integration Guide. 

 

Audience 

This guide is intended for anyone who uses the product on a daily basis to manage agile 
projects, including the following users: 

■ Product Owner (also can be the business analyst) – The person who is responsible 
for maintaining the product including release schedules, features, and 
requirements. The product owner can also review the product roadmap based on 
both master and subreleases. The product owner represents the stakeholders and 
the business. 

■ PMO (project management office or similar role) – The person responsible for 
adhering the organizational processes for setting up projects and rolling them up to 
portfolios, and so on. Often, this job is de-centralized, but for the purpose of this 
exercise, we have summarized it to a single user. 

 

■ Scrum Master (or Agile project manager) –The person who is responsible for the 
user stories and backlog. The scrum master creates sprints, manages team 
assignments, and monitors the status of the agile projects. 

■ Development Team – The users who do the day-to-day work of the sprint project. 
The development team creates tasks, updates task status (with hours and 
estimates), creates issues, and gives feedback on success to the scrum master. 

■ Portfolio Manager (also could be business manager or stakeholder) – The person 
responsible for seeing the roll-up of the agile projects with the traditional projects. 
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Log in to CA Clarity Requirements 

Your CA Clarity Requirements administrator prepares the product so that you can use it 
on a daily basis to manage your projects. After your administrator prepares the product, 
they will provide you with the URL and login credentials for you to log in. 

When you first log in to CA Clarity Requirements, you are instructed to change your 
password immediately.  

Follow these steps: 

1. Log in to CA Clarity Requirements at the following URL in your Web browser: 

https://cavision.cloudforce.com 

2. Enter a new password and confirm it. 

Your new password must meet the following criteria: 

■ At least eight characters 

■ Uppercase and lowercase alphanumeric characters 

3. Select a security question from the drop-down. 

4. Enter your answer. 

5. Save your changes. 
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Chapter 2: List Pages 
 

The CA Clarity Requirements pages have a number of convenient features to help you 
set up and manage your products more easily. The setting for the number of records to 
display on a list page is persisted for each browser and for each user. If you view the 
same list in a different browser, set this value again. 

This section contains the following topics: 

List Page View and Edit (see page 13) 
Configure Columns for a List Page (see page 14) 
List Page Filters (see page 14) 

 

List Page View and Edit 

You can edit a page, only if you have the rights to edit. You can use the Details links on 
the list pages to do the following actions: 

Edit 

You can open the details page for the item and can change the values in any of the 
fields that are active. 

Note: Details link allows you to view and edit information. 
 

View  

If you are not the creator of the list item, or the product owner, the details page 
opens in view-only mode. 

 

Edit List Page Fields 

Many fields on list pages can be edited inline, saving clicks to get to the detail page of 
the list item you want to change.  

Follow these steps: 

1. Click in a list page field to begin editing. If the field can be edited inline, it activates 
for you to change values.  

 

When you change a field value, a small red triangle appears in the upper left of the 
field indicating the updated value.  

 

2. Save your changes. 
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Note: Fields that cannot be edited in-place include fields that have more than one value. 
If you sort or group by a column field with multiple values, the sort function sorts for 
each of the values in the column field. You cannot edit the value of the field in-place 
because the changes impact multiple objects. 

 

Configure Columns for a List Page 

You can choose the columns that display on some list pages. You can remove the default 
columns and add the columns that you want. If you add custom fields (also known as 
attributes), the custom fields are available to add to the appropriate list page as 
columns. For example, if you add custom fields for requirements, the custom fields will 
be available for the requirements list page. 

 

Follow these steps: 

1. Open the list page and click Configure. 
 

2. Specify the columns that you want included in the list and the correct order. 
 

3. Save your changes. 

To restore configuration defaults for a list page, click Restore Defaults. 
 

List Page Filters 

List pages have a filter below the header that lets you control what you view on the 
page. All filters that are created for a list page appear in the Filters drop-down list for 
selection. The current filter in use on the list page shows in the Filters field.  

 

Note the following points about filters: 

■ When you filter, the selection criteria remain in effect for the list page. If you leave 
the list page and return, the list is prefiltered with the selection criteria from the 
filter.  

■ Any filter that you create is automatically saved. 
 

■ You can edit and remove filters that you have created. 

■ To override the filter criteria for the list page and show the entire list, click Clear 
Filter. 

■ Filters are saved across sessions per browser. If you switch to a different browser, 
reselect a filter to apply it. 
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Manage a List Page Filter 

List pages filter lets you control what you view on the page. Consider the following 
information about filters: 

■ When you filter, the selection criteria remain in effect for the list page. If you leave 
the list page and return, the list is prefiltered with the selection criteria from the 
filter. 

■ Any filter that you create is automatically saved. 
 

■ Filters are saved across sessions for each browser. If you switch to a different 
browser, reselect a filter to apply it. 

■ You can create and save multiple filters. 

■ To override the filter criteria for the list page and show the entire list, click Clear 
Filter. 

Follow these steps: 

1. Open the list page that you want to filter. 

2. Click Add/Edit Filter. 
 

3. Select the Create a new filter option. 

4. In the Properties section, enter a name in the Filter Name field. 

5. Make selections in the drop-down lists to define filter criteria. 
 

 

6. Click Add to define additional criteria. 

7. Click Filter when you are done. 

The list page is filtered using the criteria that you defined, and the filter is saved 
automatically. 

Note: To edit or delete a filter, click Add/Edit Filter, select Show Existing Filters, edit the 
filter, or click Delete. 
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Chapter 3: Business Planning 
 

Business planning for CA Clarity Requirements is about identifying who your customers 
are so that you can understand their business needs and the requirements they are 
interested in. The Business Planning menu contains options that let you identify and 
provide information about personas and sources. By associating a requirement with a 
source or a persona, you save important information about who requested the 
requirement and why they need it. 

This section contains the following topics: 

Example: Create a Persona and a Source (see page 17) 
Sources (see page 18) 
Personas (see page 19) 

 

Example: Create a Persona and a Source 

John Wheeler is a Net Worth product manager for Forward, Inc. John is responsible for 
helping ensure that the release and feature requirements for the product satisfy the 
needs of the customers. 

John receives market research that describes a typical buyer of a new product that he is 
planning. John receives an email from a sales representative indicating a current 
customer, Miki Wireless Devices, has expressed interest in the planned product. The 
customer has opened requirements that would help ensure a new sale to the customer. 

 

To help ensure that the information he has received on his new product is not lost, John 
completes the following tasks in CA Clarity Requirements: 

■ To capture the market research information about the typical buyer, John creates a 
persona for the buyer and names the persona Charlie Smith. John indicates that the 
persona is the chief technical officer in a telecom hardware company. To complete 
the persona, John adds additional information from the market research about 
product needs, pain points, and buying habits.  

 

■ To capture the information from the current customer, John creates a source of 
type Customer for the company Miki Wireless Devices. Because the company is 
based in Japan, John selects the Geo Segment Japan. He completes the remaining 
information for the source, including information about who to contact in the 
company. 

 

John creates the requirements Miki Wireless Devices has requested in the new product. 
As he creates the requirements in CA Clarity Requirements, he selects the source Miki 
Wireless Devices to link the requirements to the requester. The new requirements can 
now be traced to Miki Wireless Devices as they go through the development cycle. 
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Because the requirements also fit the needs of the Charlie Smith persona profile, John 
associates the requirements with that persona. Because he associated the source and 
persona, John can quickly look at the requirements and see which markets, customers, 
and personas value the requirements. This information can be invaluable if changes in 
the scope of the product require prioritizing which requirements are included in the 
scope.  

 

Sources 

You can define a profile for a source of a requirement. Sources let you trace 
requirements back to their origins. Knowing how many sources and who requested a 
requirement can help you determine how quickly the requirement must be delivered. It 
is a factor in determining which requirements get done for a release of a product. 

 

Sources can provide information about which geographic or market segments are 
involved. CA Clarity Requirements provides the following source types: 

■ Business unit. Identifies a requirement from internal parts of your business. 

■ Customer. Identifies a requirement from active or prospective customers. 
 

■ Geography. Identifies a requirement specific to one or more geographies. 

■ Industry. Identifies a requirement specific to one or more industries. 
 

You can define additional custom fields (attributes) for a source. The custom fields are 
helpful, when the default fields provided are not adequate for the information you want 
to collect and store for sources. Additional custom fields are added from the 
Administration menu.  

See the Administration Guide for more information. 
 

Manage a Source 

Create a source to describe the originator of a requirement or an organization that is 
interested in having a requirement fulfilled.  

Follow these steps: 

1. Click Requirements, and from the Business Planning, click Source. 

The source list page appears. 
 

2. Click New Source. 

3. Complete the requested fields. 
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4. Save your changes. 

After you create a source, you can edit the source to add more details. 

Note: To edit or delete a source, select the source from the source list, and click Details. 
 

Personas 

A persona can be a real or a composite of a person who represents a buyer or influences 
the decision to buy a product.  

Associating a persona with a requirement provides detailed information about who is 
expecting a requirement to complete and how the requirement fits into the business 
model for the person. A persona can provide information about the issues that the 
requirement satisfies including business needs, pain points, and buying habits. 

 

Manage a Persona 

Create a persona to indicate a person in an organization or a representative composite 
of a person who can influence a decision to buy your product. Once you create the 
persona, you can add full information by editing persona details. 

Follow these steps: 

1. Click Requirements, and from the Business Planning, click Persona. 

The persona list page appears. 
 

2. Click New Persona. 

3. Complete the appropriate fields. 

4. Save your changes. 

After you have created the persona, you can add more detail by editing the persona 
details. 

Note: To edit or delete a persona, select the persona from the persona list, and click 
Details or Delete. You can click the Details link on the persona list, and edit the details 
on the Persona Details page. To delete a persona, click Delete from the Persona Details 
page or from the persona list. 
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Chapter 4: The Product Roadmap 
 

The product roadmap displays the release time line for multiple products. The roadmap 
provides a view of master releases, with a high-level view and drill-down into releases 
and requirements. The monthly, quarterly, and yearly views show short-term and 
long-term implementation plans for delivering requirements and features.  

From the roadmap, you can easily link to product, release, and requirement detail 
pages, to view, create, edit, clone, and delete objects. Once you configure the products 
to view on a roadmap, the settings are retained for subsequent views. 

This section contains the following topics: 

View Details for Items in the Roadmap (see page 21) 
View Requirements Associated with a Product Release (see page 22) 
Configure the Roadmap Display Options (see page 22) 
View Products Associated with Master Releases (see page 22) 

 

View Details for Items in the Roadmap 

You can check the roadmap to view high-level information for an item, such as a release. 

Follow these steps: 

1. Click Requirements, and from the Business Planning, click Product Roadmap. 

2. Click Filter Products, and select the products that you want to display. 

3. Save your changes. 

The Product Roadmap displays information for all the selected products. 

4. To view details for an item, choose one of the following options: 

■ To view high-level information, hover over the object with the pointer. 
 

■ To view the details of the release or requirement object in the Roadmap area, 
click the object. 

5. To display nested items, expand master releases, products, releases, or features. 
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View Requirements Associated with a Product Release 

You can view a list of requirements that are nested under a release. The Roadmap 
displays all the requirements regardless of its version status. 

Note: If you have assigned a requirement to a feature, the Show Features option must 
be selected. Requirements that are not assigned to a feature are nested under 
"Unassigned". 

 

Configure the Roadmap Display Options 

You can configure color options for the roadmap objects to help distinguish between 
the types of objects. 

Follow these steps: 

1. Click Requirements, and from the Business Planning, click Product Roadmap. 

2. Click Configure.  

The Configuration pop-up window appears. 
 

 

3. Select the bar and text colors for each object type. 

4. Save your changes. 
 

View Products Associated with Master Releases 

On the Product Roadmap, you can view the products that are associated with a master 
release. Hover over the master release object from the roadmap. The tooltip for the 
master release displays the associated product names. 
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Chapter 5: Product Setup 
 

This section contains the following topics: 

Manage a Product (see page 23) 
Change the Product Owner (see page 24) 
How to Define a Competing Product (see page 24) 
Create a Release or Requirement for a Product (see page 24) 
Link to Quality Center Projects (see page 25) 
Planned and Actual Values (see page 26) 

 

Manage a Product 

When you create a product, you create a detailed picture of the product for future 
reference. You can include information about finances, customers, competing products, 
geographic market segment, industry market segment, and features. You can also 
include more in-depth information about the strengths, weaknesses, opportunities, 
threats, and the problems that are addressed for the product. 

After you create the product, edit the product details to add more information about all 
aspects of the product. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Products. 

The products list page appears. 
 

2. Click New Product. 
 

3. Complete the requested fields. 
 

4. Save your changes. 

Note: To edit or delete a product, select the product from the product list, and click 
Details or Delete. 
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Change the Product Owner 

When you create a product, you are the owner of the product by default. You can 
however, change the ownership of the product to another user or add additional 
owners. The new owner gains the right to change the product details. Only a current 
owner or the creator of a product can change the details of a product. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Products. 

2. Click Details in the Actions column for the product you want to work with. 

3. Click Browse in the Product Owners field. 

4. Select a new product owner. 

5. Save your changes. 
 

How to Define a Competing Product 

You define a competing product in the same way you define a product for your 
company. When a product is marked as a competitor, it becomes available for selection 
as a competitor you can associate with one of your products.  

To define a competing product, create a product and make sure the Competitor check 
box on the Product Details page is selected. 

 

Create a Release or Requirement for a Product 

You can associate an existing requirement or create a requirement for the product. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Products. 

2. Click Details for the product you want to work with. 

The Product Details page appears. 
 

3. Click New in the Requirements section. 

4. Complete the requested fields. 

5. Save your changes. 
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Link to Quality Center Projects 

If CA Clarity Requirements is configured to integrate with Quality Center, you can map a 
product to existing Quality Center project. The test cases that are associated with the 
Quality Center project get mapped to the product. 

For more information integrating with Quality Center, see the CA Clarity Agile 
Integration Guide. 

 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Products. 

The products list page appears. 
 

2. Click New Product. 

3. Complete the requested fields. The following fields require explanation: 

Map this product to 

Select an HP Quality Center project that you want to map. 

Note: This option is available only if the system administrator has enabled 
Integration with Quality Center from the Global Configuration Page. 

4. Save your changes. 
 

Link the Quality Center Test Cases to Requirement 

If a product is mapped to the Quality Center project, you can link the test cases of the 
project to the requirement associated with the product. 

If you delete a test case from a requirement in CA Clarity Requirements, the test case 
itself is not deleted from CA Clarity Requirements or Quality Center. Only the 
association between the test case and the requirement is broken. 

 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

The requirements list page appears. 
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2. Click Details for the requirement you want to work with. 

Note: Link the requirement to the product which is mapped to the Quality Center 
project. 

3. Scroll to the Test Cases section and click Link to Testcases. 

4. Select a Quality Center folder to display the test cases in that folder. 

Note: A regular scheduled task syncs the Quality Center projects and test case data 
with CA Clarity Requirements. Any new test case on Quality Center will be available 
on CA Clarity Requirements only after the next successful execution of scheduled 
task. 

5. Select one or more test cases. 

6. Save your changes. 
 

Planned and Actual Values 

You can see planned and actual values for a product, release, or feature. The following 
values are displayed on the list pages and on individual detail pages: 

■ Planned Cost 

■ Actual Cost 

■ Planned vs Actual Cost 

■ Planned Effort 

■ Actual Effort 

■ Planned vs Actual Effort 

This information is aggregated from the planned and actual values present for the 
requirements that are associated with the product, release, or feature. The aggregated 
values are read-only and cannot be edited. 
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Chapter 6: Releases 
 

CA Clarity Requirements has the following release types: 

■ Product release 

This release type indicates an update or change to a product and therefore must be 
associated with a single product. If CA Clarity Agile is also used, any releases that 
are created also appear in CA Clarity Agile. 

 

■ Master release 

This release type can be associated with multiple products and their releases. When 
you assign a product release to a master release, all user stories and requirements 
within the release are automatically assigned to the master release. 

 

If the product is associated with the master release, you can associate individual 
user stories or requirements.  

Note: For more information about master releases, including how to create a master 
release, see the Administration Guide. 

This section contains the following topics: 

Manage a Product Release (see page 27) 
Associate a Product Release with a Master Release (see page 28) 
Set a Baseline for a Product Release (see page 29) 
Compare Release Baselines (see page 29) 

 

Manage a Product Release 

If you are the product owner or the system administrator, you can create a release for a 
product. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Releases. 

The release list page appears. 
 

2. Click New Release. 
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3. Complete the following fields: 

Target Cost 

Defines the total planned cost for the release. This value is a high-level 
estimate that can be entered and edited in CA Clarity Requirements. When CA 
Clarity PPM and CA Clarity Requirements are integrated, planned cost 
information comes from CA Clarity PPM and the field is read-only in CA Clarity 
Requirements. This field is a way to enter and track original rough estimates 
directly using CA Clarity Requirements. 

 

Target Effort 

Defines the total planned effort for the release in hours. This value is a 
high-level estimate that can be entered and edited in CA Clarity Requirements. 
When CA Clarity PPM and CA Clarity Requirements are integrated, planned 
effort information comes from CA Clarity PPM and the field is read-only in CA 
Clarity Requirements. This field is a way to enter and track original rough 
estimates directly using CA Clarity Requirements. 

 

4. Save your changes.  

After you create the release, edit the release details to add complete information about 
all aspects of the release. 

Note: To edit or delete a product release, select the release from the release list, and 
click Details or Delete. 

 

Associate a Product Release with a Master Release 

Follow these steps: 

1. Open the releases list page and click Details in the Actions column of the release 
you want to associate with a master release. 

The Release Details page appears.  

2. In the Master Release field, select a master release. 

3. Save your changes. 
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Set a Baseline for a Product Release 

A baseline is a snapshot of requirements at a specific point in time. Baselines are static, 
and changes you make after the baseline is created do not automatically appear in the 
current baseline.  

You can create a second baseline to include newly entered or changed requirements. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Releases. 

2. Click Details in the Actions column for the release you want to work with. 

The Release Details page appears. 

3. In the Baseline section, click New Baseline. 

Today’s date and time are added to the record as the baseline date. 
 

Compare Release Baselines 

Any changes made to the requirements for a release after the baseline is created, do 
not appear under the current baseline. Create another baseline and you can do a 
comparison of the two baselines. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Releases. 

2. Click Details in the Action column for the release you want to work with. 

The Release Details page appears. 

3. In the Requirements section, highlight the two baselines you want to compare, and 
click Compare Baseline. 

The result shows a comparison of the requirements between the two baselines. 
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Chapter 7: Features 
 

Features describe the abilities of the product. You can associate a feature with a single 
product when the feature is created. A feature can be linked to multiple requirements. 
You can view the planned and actual information for the feature requirements rolled up 
to the feature level. 

This section contains the following topics: 

Manage a Feature (see page 31) 
Add a Note or Attachment to a Feature (see page 32) 
View the Feature Hierarchy (see page 32) 
Planned and Actual Values (see page 33) 

 

Manage a Feature 

You can create a feature to describe new functions and abilities of a product. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Features. 

The features list page appears. 

2. Click New Feature. 
 

3. Complete the required fields. The following fields require explanation: 

Target Cost 

Defines the total planned cost for the feature. Target cost is a high-level 
estimate that can be entered and edited in CA Clarity Requirements. When CA 
Clarity PPM and CA Clarity Requirements are integrated, planned cost 
information comes from CA Clarity PPM and the field is read-only in CA Clarity 
Requirements. This field is a way to enter and track original rough estimates 
directly using CA Clarity Requirements. 
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Target Effort 

Defines the total planned effort for the feature in hours. Target effort is a 
high-level estimate that can be entered and edited in CA Clarity Requirements. 
When CA Clarity PPM and CA Clarity Requirements are integrated, planned 
effort information comes from CA Clarity PPM and the field is read-only in CA 
Clarity Requirements. This field is a way to enter and track original rough 
estimates directly using CA Clarity Requirements. 

4. Save your changes. 

After you create the feature, edit the feature details to add complete information about 
all aspects of the feature. 

Note: To edit or delete a feature, select the feature on features list page, and click 
Details or Delete. 

 

Add a Note or Attachment to a Feature 

You can add notes to give additional information for the feature. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Features. 

2. Click Details in the Actions column of the feature. 

The Feature Details page appears. 
 

3. In the Notes & Attachments section, do one of the following: 

■ Click New Note and complete the required fields. The following fields require 
explanation: 

Private 

Specifies only the creator can view or edit the note. 

■ Click Attach File and browse the required file. 
 

4. Save your changes. 
 

View the Feature Hierarchy 

You can view the requirements that belong to each feature in the Feature Hierarchy 
view.  

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Features. 
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2. In the View field at the top of the list page, select Feature Hierarchy. 

The list of features displays with any associated requirements. 
 

3. Click Expand All to display the requirements that are associated with the feature. 
 

Planned and Actual Values 

You can see planned and actual values for a product, release, or feature. The following 
values are displayed on the list pages and on individual detail pages: 

■ Planned Cost 

■ Actual Cost 

■ Planned vs Actual Cost 

■ Planned Effort 

■ Actual Effort 

■ Planned vs Actual Effort 

This information is aggregated from the planned and actual values present for the 
requirements that are associated with the product, release, or feature. The aggregated 
values are read-only and cannot be edited. 
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Chapter 8: Managing Requirements 
 

This section contains the following topics: 

Requirements (see page 36) 
View and Manage Requirements Lists (see page 36) 
Example: Plan Feature Requirements Over Releases (see page 38) 
How to Work with Requirement Versions (see page 39) 
How the Product Owner Manages Requirement under RCM (see page 45) 
Requirement Hierarchies (see page 49) 
How to View CA Software Change Manager Package Information (see page 51) 
Associate a Requirement with a Product Release (see page 53) 
Associate a Requirement with a Master Release (see page 53) 
Associate a Requirement with a Feature (see page 53) 
Create a Requirement for a Product, Release, or Feature (see page 54) 
Create a Requirement for a Source (see page 54) 
Link Existing Requirements with a Product (see page 54) 
Merge Requirements (see page 55) 
Delete a Requirement (see page 56) 
How to Estimate Resources and Effort for a Requirement (see page 56) 
Attach a Note or Attachment to a Requirement (see page 57) 
Track Requirements with Charts and Reports (see page 58) 
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Requirements 

You create requirements to identify and track needed abilities for the product. 

Requirements that you create are listed on the Requirements list page. You can filter 
and sort the requirements to see only the information you want in the list. You can 
enter requirements in CA Clarity Requirements using one of the following methods: 

■ Click the Requirements link on the Detailed Planning menu and click New 
Requirement. 

■ Open the details page for a product, source, release, or feature and click New 
Requirement in the Requirements section. 

You can view requirements for a specific product, release, and feature from the detail 
page for that object. 

Requirements use version control to manage drafts and approved versions of a 
requirement. When you create and save a requirement, the Status field changes to 
Draft. The method for creating an approved version depends on whether Requirement 
Change Management (RCM), is enabled: 

■ If RCM is enabled, the requirement owner sends an approval request to the product 
owner. The product owner approves or rejects the requirement draft. If approved, 
the requirement state changes to Approved and the version number of the 
requirement increments. 

■ If RCM is not enabled, either the requirement owner or the product owner can 
create a new approved version. The status changes to Approved and the version 
number increments. 

 

View and Manage Requirements Lists 

The Requirements list page has three list viewing options available: 

All Records 

From this view, you can create new requirements, or can view and edit individual 
requirements. 

 

Requirement Hierarchy 

Default view of the requirements list page. Use this view to see and manage 
parent-child relationships between requirements and to create new requirements. 

Traceability Matrix 

Use this view to see the user stories that are associated with a requirement. You 
can also click a link to see the detailed information about the requirement, 
including associated source and persona information. 
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View the Traceability Matrix 

The Traceability Matrix allows you to see the origin of a requirement and any user story 
that is associated with the requirement through CA Clarity Agile.  

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. In the View field, select Traceability Matrix. 

3. Click one of the following links for information: 

■ Click a requirement name to see detailed information about the requirement. 
The requirement includes the source or persona that originated the 
requirement and product and release information. 

■ Click a user story name to see details about how the requirement is being 
fulfilled in CA Clarity Agile. 

You can filter the Traceability Matrix requirements using the filter options. Click 
Add/Edit Filter to create a filter, specify the criteria, and click Filter to filter the view. 

 

View the Requirements Hierarchy 

The requirements hierarchy lets you quickly identify which requirements have been 
associated as parent and child. The list shows in order by parent, with the children 
below the parent. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. In the View field, select Requirements Hierarchy. 
 

From this list, you can perform the following tasks:  

■ Click in a field to update values in-line. The field activates if the value can be 
updated. 

■ Right-click on a requirement to see a menu to delete, expand, collapse, or edit 
details of the requirement. 
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You can create an unlimited number of levels in a hierarchy. 

 
 

Example: Plan Feature Requirements Over Releases 

Mark Wilson is the product owner for an existing Forward, Inc. flagship product. Mark 
owns a mature software application that is healthy and currently produces a strong 
revenue stream. However, the product is in need of a revision to keep up with recent 
advances by competitors.  

 

Mark has a list of requirements that have been entered into CA Clarity Requirements by 
sales, support, and marketing. He manages the requirements over a number of releases 
in the next fiscal year. To manage the requirements using CA Clarity Requirements, 
Mark does the following: 

■ Determines the product features to be implemented and creates the features in CA 
Clarity Requirements. 

Mark examines the current requirements to determine which features to 
implement and in what order. Some requirements can be grouped into one feature. 
Mark determines that six product features are required (Features A, B, C, D, E and 
F). He also determines that all of the requirements for Feature A cannot be 
completed in one release, and must be spread across multiple releases. 

 

■ Determines the number of releases required and creates the releases in CA Clarity 
Requirements.  

Mark determines that three releases are required to implement the features and 
requirements he has listed. The releases are Spring 2011, Summer 2011, and Winter 
2011. 

 

■ Assigns requirements to the features. 

Mark assigns 72 requirements to the six features from the requirements list view. 
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■ Assigns the requirements of Feature A across multiple releases. 

Mark assigns the following requirements from Feature A to the individual releases: 
five to the Spring 2011 release, seven to the Summer 2011 release, and three to the 
Winter 2011 release. From the requirements list page, he makes the assignments 
by highlighting the requirements and clicking Assign to Release. 

 

How to Work with Requirement Versions 

Version control provides you the ability to create drafts and current versions of 
requirements. When a CA Clarity Requirements user creates and saves a requirement, a 
draft of the requirement is added to the list of requirements. The user that creates the 
requirement becomes the requirement owner. 

 

When the requirement owner becomes satisfied with the content of the requirement, 
they can create an approved version of the requirement. If Requirement Change 
Management is enabled, the requirement owner must submit the draft for approval to 
create an approved version. 

When you have multiple versions of a requirement, you can compare differences 
between versions. 

 

The following diagram shows how the requirement owner manages requirement 
versions. 
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To work with versions of requirements, complete the following tasks. 

■ Create a Requirement Draft (see page 44). 

■ Create a New Version of a Requirement (see page 41). 

■ Compare Requirement Versions (see page 42). 

 
 

Create a Requirement Draft 

You can create a draft of the requirement so that you can review it before creating a 
version. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

The Requirements list page appears. 

2. Click New. 

The New pop-up dialog opens to create a requirement. 
 

3. (Optional) Click Configure to add more fields or change the order of columns in the 
requirement page. 

– Select the fields and layout. 

Note: You cannot configure some custom attributes including Email, Date/Time, 
Phone, Encrypt Text, Picklist (multi-select), Auto Number, Roll-up Summary, Lookup 
relations, URL, and Master-detail relationship. 

 

4. Fill in the required fields. 

Category 

Specifies a way to group requirements that is defined by your company. Select 
one of the options from the drop-down. 

Complexity 

Specifies the degree of difficulty that can be expected in completing the 
requirement. 

State 

This field is defined by your company. Typically, this field is used to label 
different workflow stages for a requirement. 

Important! If you configure the optional fields after this step, all the populated 
details in the fields will be lost. Always configure the optional fields before 
completing the default fields. 
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5. Save your changes. 

The requirement is created. The status of the requirement is Draft. 
 

Note: To delete the requirement, in the Requirement list, select the requirement that 
you want to delete, and click Delete. 

 

Create a New Version of a Requirement 

When you create a requirement, the Version Status is set to Draft. To create an 
approved version, you complete one of the following tasks: 

■ If Requirement Change Management (RCM) is enabled, submit an approval request 
(see page 44). 

■ If RCM is not enabled, create a version. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. Select All Records from the View drop-down list. 

3. Click Details in the Actions column of the requirement you want to work with. 

4. Click Create New Version. 

5. Select which type of version to create: 

Minor 

Specifies a point (0.1) increase in the version number. 

Major 

Specifies a whole number (1.0) increase in the version number. 

6. Click Create. 

The following fields or sections have updated values: 

Version Status 

The value changes from Draft to Approved. 

Current Version Number 

The value increases by a decimal point or whole number, which specifies a 
minor or major version type. 

Versions 

A record is added to the Versions section, with the new version number and a 
time stamp. 
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Compare Versions of the Requirement 

You can compare versions of the requirement to check the changes in the new version. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. Select All Records from the View drop-down list. 

3. Click Details for the requirement you want to work with. 

4. Navigate to the Versions section and click Compare Versions. 

The differences between the current version and the older version is shown. 
 

How to Submit a Requirement for Approval under Change Management 

With Version Control, requirements are in either a draft or approved state and the 
requirement owner can create an approved version. However, when Requirements 
Change Management (RCM) is enabled, the requirement owner must go through an 
approval process to create an approved version.  
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To change a requirement to approved, submit the draft for approval. The requirement 
status changes from the draft to submitted. 

If the requirement is approved, the status of the requirement changes from submitted 
to approved. 

  

You must be a valid CA Clarity Requirements user to create a requirement and submit it 
for approval. 

1. Create or edit a requirement draft. (see page 44) 

2. Submit a requirement draft for approval (see page 44). 
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Create or Edit a Requirement Draft 

As a requirement owner, create a requirement draft or edit an existing draft. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. Complete one of the following tasks: 

■ Create a requirement draft (see page 40). 

■ Edit the details of an existing requirement. (see page 48) 

When you edit and save the requirement, the status of the requirement 
changes to draft: 

3. Complete the requested fields. 

4. Save your changes. 

The requirement appears in the requirement list with Draft in the status column 
and is ready to be submitted for approval. 

 

Submit a Requirement Draft for Approval 

Once you have changed the requirement, you can submit it for approval. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. Select All Records from the View drop-down list. 

3. Click Details for the requirement you want to work with. 

4. Review the draft, and when it is ready for approval, click Submit for Approval. 

The Submitting for Approval pop-up dialog opens. 
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5. Select one of the following Version Type options: 

Minor 

Specifies that the updates are small editorial changes or field changes such as 
entering the Actual Effort. The version changes by one point (0.1). 

Major 

Specifies that the updates are significant, such as changing the release 
associated with the requirement, changing the scope of the requirement, or 
increasing the complexity of the requirement. The version changes by one full 
version number (1.0). 

6. Click Submit. 

In the Approval History section, an entry is added for the approval request. The 
status of the requirement is Pending. 

The product owner, receives an email notification about the request. 

If the approver approves the requirement, the version number increases and the status 
changes to Approved. 

If the approver rejects the requirement, the requirement remains in draft status without 
a change in the version number. 

 

How the Product Owner Manages Requirement under RCM 

You can use RCM to assist with version control and approval management for 
requirements. When change management is enabled and a team member creates a 
requirement, a draft version is created. The creator of the requirement is called the 
requirement owner. The requirement owner must be specified as a product owner to 
select the products for the new requirement. 

After requirement owners create a requirement, they submit the requirement for 
approval to the product owner. The requirement changes from draft status to pending 
status until it is approved or rejected. A product owner approves, tracks, and restores 
versions of a requirement. After the product owner approves the draft requirement, the 
status changes to Approved, and the version number of the requirement increases. 
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The product owner can monitor requirement changes through Chatter updates.  

The following diagram shows the process for managing the approval cycle. 

 
 

Complete the following tasks to manage requirements under RCM. 

■ Approve or Reject Requirement Versions (see page 47). 

■ Restore a Previous Version of a Requirement (see page 48). 
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Approve or Reject Requirement Versions 

After the requirement owner submits an approval request, the product owner receives 
an email indicating that a requirement needs approval. The email contains a URL link for 
the approval request. 

The product owner reviews the request and either approves or rejects the requirement 
draft. 

Follow these steps: 

1. Click Requirements, Detailed Planning, click Requirements. 

2. Click Details for the requirement you want to review. 

The Requirement Details page appears. 

Note: You can also click the link in the email and open the Requirement Details 
page. 

3. Scroll to the Approval History section, and click Approve/Reject for the pending 
request.  

The Review Requirement page appears. 
 

4. Click Approve or Reject. 

The status of the requirement updates depending upon whether the product owner 
approves or rejects the requirement. If the requirement is approved, the 
requirement has a status of Approved and a new version is created. If the 
requirement is rejected, the status appears as Draft and a new version is not 
created. 
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Restore a Previous Version of the Requirement under RCM 

You can create a version of an approved requirement using the values from a previous 
version. This process is called restoring a version. You must have privileges of either a 
product owner or the requirement owner to restore a version. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. Select All Records from the View drop-down list. 

3. Click Details for the requirement you want to work with. 

4. Navigate to Versions list in the Requirement Details page. 

Tip: Click Compare Versions to check the differences between the current version 
and the older version.  

5. Select the number of the earlier version and click Restore. 

The Restore pop-up dialog opens. 

6. Specify the version type and click Restore. 

If you are the product owner, new version is created. 

7. If you are the requirement owner, do the following: 

■ Click Submit for Approval, if RCM is enabled. 

■ Click Create New Version, if RCM is disabled. 

When a new version is either created or approved, the requirement field values revert 
to the values of the previous version. Additionally, the version number increases by the 
specified number. 

 

Edit Requirement Details 

You can edit the details for a requirement. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. Select All Records from the View drop-down list. 

3. Click Details for the requirement you want to edit. 

4. Complete the requested fields.  

When CA Clarity Requirements is integrated with CA Clarity PPM, the data comes 
from CA Clarity PPM and any manual edits is overwritten. You cannot edit the data. 

5. Save your changes. 
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Requirement Hierarchies 

You can break a requirement into smaller child requirements that suit your business 
needs. You can create a hierarchy of requirements with parents, children, and 
grandchildren. You can create an unlimited number of levels in a hierarchy. 

To see the results of a creating a hierarchy, view the Requirements Hierarchy page. This 
page is available by clicking Requirements in the Detail Planning menu, then selecting 
Requirements Hierarchy in the View field. 

 

Example: Define Requirements in a Hierarchy 

Carol Martinez is a business analyst for Forward, Inc. She captures a set of high-level 
business requirements from Marketing regarding a business analytics system. Carol 
enters the high-level requirements in CA Clarity Requirements, where they are displayed 
in the list view. 

 

The high-level requirements from Marketing are not broken into manageable work units 
that the IT department can use to make system modifications. Carol must break the 
high-level requirements into smaller child requirements that describe the specific 
features and changes needed in the current system. 

 

Carol selects a category of Business Requirement for the high-level requirements. She 
then selects the category of Technical Requirements for the child requirements under 
each high-level requirement. The system administrator configured the requirement 
categories to meet the needs of Forward, Inc. By selecting different categories for the 
parent and children, Carol can sort the requirements on the list page by category. She 
can also print the requirements by category. 

 

Each of the requirements is also associated with Forward, Inc. Marketing as the source. 
Marketing personnel can then view the requirements from the Marketing source and 
check that the requirements are being fulfilled. 

 

Carol finds that she needs multiple levels to break down the high-level requirements 
into basic requirements. She creates children under the appropriate child requirements 
until she has reached the basic requirement level. The result is a requirement tree with 
five levels of child requirements. The IT department then assesses whether the 
requirements can be accomplished using the current system. 
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Create a Child Requirement 

You can break the high-level requirements into smaller child requirements that describe 
the specific features and changes needed in the current system. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. Select the requirement that is to be the parent and click New Child. 

3. (Optional) Click Configure to add more fields or change the order of columns in the 
requirement page. 

– Select the fields and layout. 

Note: You cannot configure some customer attributes including Email, Date/Time, 
Phone, Encrypt Text, Picklist (multi-select), Auto Number, Roll-up Summary, Lookup 
relations, URL, and Master-detail relationship. 

 

4. Complete the required fields. 

Important! If you configure the optional fields after this step, all the populated 
details in the fields will be lost. Always configure the optional fields before 
completing the default fields. 

5. Save your changes. 
 

Edit Child Requirement Details 

You can edit the details for a requirement. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. Select Requirement Hierarchy from the View drop-down list. 

3. Expand the parent requirement to display the chid requirement. 

4. Right-click the child requirement that you want to work with and click Details. 

5. Complete the requested fields.  

Note: When CA Clarity Requirements is integrated with CA Clarity PPM, the data 
comes from CA Clarity PPM and any manual edits is overwritten. You cannot edit 
the data. 

6. Save your changes. 
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How to View CA Software Change Manager Package 
Information 

You can integrate with CA Software Change Manager (CA Software Change Manager) to 
view information about packages related to requirements. 

Important:To integrate with CA Software Change Manager, the system administrator 
must enable integration with CA Software Change Manager. 

 

After the integration has been enabled, you can perform the following tasks from a 
requirement: 

■ View CA Software Change Manager packages that are related to the requirement. 
(see page 51) 

■ Open the CA Software Change Manager Package Detail page (see page 52) to see 
high-level package information. 

 

View CA Software Change Manager Packages 

If the system administrator has enabled integration with CA Software Change Manager, 
you can view a list of packages related to a requirement. Packages appear in CA 
Software Change Manager section of the detail page. 

The CA Software Change Manager section displays a list of packages with the following 
information: 

Package Name 

The name of the package associated with a requirement. The name has a link to the 
CA Software Change Manager Package Detail page for the package.  

Click on the package name to view more detail about the package. 
 

SCM Project 

The name of the related project in CA Software Change Manager 

Broker 

The CA Software Change Manager broker 

Created By 

The user ID that created the package 
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View CA Software Change Manager Package Detail 

The CA Software Change Manager Package Details page displays package history and 
code changes associated with a requirement. The information on this page is read-only. 

You can link to this page from the CA Software Change Manager section in the detail 
page for the requirement. 

 

The CA SCM Package History table displays the following information: 

Action 

The most recent activity that is performed on the package. 

State 

The current phase in the development lifecycle, such as "Development". 

Modified By 

The name of the user that last modified the module. 

Date Changed 

The date on which the module was last changed. 
 

The SCM Code Changes table displays the following information: 

Item Name  

The name of the created item that is checked in to a CA Software Change Manager 
repository. 

Path 

The path of the item in the repository. 

Version number 

The iteration of an item in the repository. 

Date Changed 

The date on which the module was last changed. 

Modified By 

The name of the user that last modified the item. 
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Associate a Requirement with a Product Release 

You can associate a requirement to the release. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. Select the requirement or requirements you want to assign and click Assign to 
Release. 

A releases selection window appears showing the associated releases for the 
product or products that are associated with the requirement. 

 

3. Select the appropriate release or releases to assign and click Add. 

The requirements are added to the selected releases. To verify, open the details 
page of one of the selected releases and check the Requirements section. 

 

Associate a Requirement with a Master Release 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. Select All Records from the View drop-down list. 

3. Click Details for the requirement you want to work with. 

4. Select the master release from the Master Releases field. 

5. Save your changes. 
 

Associate a Requirement with a Feature 

You can assign a requirement to only one feature per product. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. Select the requirement or requirements you want to assign and click Assign to 
Feature. 

A features selection window appears showing the associated feature for the 
product or products that are associated with the requirement. 

 

3. Select the appropriate feature or features to assign and click Add.  

The requirements are added to the selected features. To verify, open the details 
page of one of the selected features and check the Requirements section. 
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Create a Requirement for a Product, Release, or Feature 

You can create a requirement or a child requirement from a Product Details, Release 
Details, or Feature Detail page. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Product, Releases, or 
Features. 

 

2. View the details for the specific product, release, or feature. 
 

3. Scroll to the Requirements section and click New or New Child. 

4. Complete the requested fields. 

5. Save your changes. 
 

Create a Requirement for a Source 

You can create a requirement or a child requirement from the Source Details page. Any 
requirement that you create from this page is automatically associated with the source. 

Follow these steps: 

1. Click Requirements, and from Business Planning, click Source. 
 

2. Click Details for the source in the list you want. 

The Source Details page appears. 
 

3. Scroll to the Requirements section and click New or New Child. 

4. Complete the requested fields. 

5. Save your changes. 
 

Link Existing Requirements with a Product 

You can link existing requirements with a product.  

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Products. 

2. Click Details in the Actions column of the product you want to work with. 

3. In the Requirements section, click Link Requirements. 

A list of available requirements appears. 

4. Select the requirements that you want to link to the product and click Add. 
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Merge Requirements 

You can merge two or more requirements into a single requirement. When you merge 
requirements, select one of the requirements as the master. The remaining merged 
requirements become inactive children requirements that are listed only on the master 
requirements page. 

Important! Once you merge requirements, this action cannot be undone. 

The following rules apply for merging requirements: 

■ The information in list boxes for the parent and children appears in the master 
requirements detail page: 

– Products 

– Product Owner 
 

– Releases 

– Personas 
 

– Sources 

– Features 
 

■ The following fields are not merged, but the information remains specific to the 
individual requirements, whether they are the parent or the child: 

– Requirement ID 

– Labor Estimate 
 

– Cost Estimate 

– Complexity 
 

– Priority 

– Type 
 

– Title 

– Financial Benefits 
 

– Theme 

– Confidence Level 
 

– Category 

– State 
 

– Is Active 

Note: You can open and view the inactive children requirements that appear on the 
master requirement detail page. 
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Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. Select All records from the View drop-down list. 
 

3. Select the requirements that you want to merge and click Merge. 

The merge page appears with the selected requirements listed. 
 

4. Select the requirement that is to be the master requirement and click Merge. 

The detail page of the parent appears with the merged requirements listed as child 
requirements. 

 

Delete a Requirement 

You can delete requirements in the following ways: 

■ Deleting a requirement from the Requirements list page, deletes the requirement 
from CA Clarity Requirements, regardless of any associations with products, 
releases, features, sources, or personas. 

 

■ Deleting a requirement from a product, release, or feature does not remove the 
requirement from CA Clarity Requirements.  

 

■ If the product is the last product association for the requirement, you cannot delete 
the requirement from the product. 

 

■ Deleting a requirement from a release or feature does not delete the requirement 
from the associated product. 

 

How to Estimate Resources and Effort for a Requirement 

A requirement can have multiple resource roles. For example, a development 
requirement needs a manager role, a designer role, a developer role, and a quality 
assurance role. You can associate resource roles with a requirement and can estimate 
the amount of effort it takes for each role to complete the requirement.  

 

For information about how to define roles for selection in CA Clarity Requirements, see 
the Administration Guide. 

To estimate the resources and effort for a requirement, you must: 

1. Add a resource role for the requirement (see page 57). 

2. Estimate the effort for a resource role (see page 57). 
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Add a Resource Role for a Requirement 

You can add resource roles that are required to complete the requirement. You can add 
roles only if you are the requirement owner. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. Select the requirement and click Details. 

The Requirement Details page opens. 
 

3. In the Role section of the detail page, click Add Role. 

The Select Roles window appears. 

4. Select the roles that you want to add for the requirement and click Add. 

The roles appear in the Roles section list for the requirement. 
 

Estimate the Effort for a Resource Role 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. Select the requirement and click Details. 

The detail page for the requirement opens. 

3. In the Role section, locate the role and click in the Labor Effort column on the row, 
then enter the full-time estimated hours. 

A red arrow appears in the upper left of the Labor Effort cell, indicating an editing 
change has been made but not saved. 

4. Save your changes. 
 

Attach a Note or Attachment to a Requirement 

You can add notes to give additional information for the feature. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. Click the title of the requirement you want to work with. 

The Requirement Details page appears. 
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3. In the Notes & Attachments section, do one of the following: 

■ Click New Note and complete the requested fields. The following fields require 
explanation: 

Private 

Specifies only the creator can view or edit the note. 

■ Click Attach File and browse the required file. 

4. Save your changes. 
 

Track Requirements with Charts and Reports 

You can track your requirements through predefined charts and reports. These charts 
are available on the Salesforce.com CA Clarity Public Dashboard. 

Follow these steps: 

1. Log in to CA Clarity Requirements and click Setup. 

2. Click the Dashboards tab. 

The dashboard appears. If the CA Clarity Requirements dashboard is not visible, 
click Go to Dashboard List, under the dashboard title. The CA Clarity Public 
Dashboard appears. 

 

3. Select Requirements Dashboard. 

The dashboard appears with the following charts: 

■ Requirements - State Bar Chart 

■ Requirement - Product Pie Chart 
 

■ Requirement - Average Age Line Chart 
 

■ Requirement - Release Pie Chart 
 

■ Requirement - Trend Line Chart 
 

■ Requirement - Source Pie Chart  
 

4. Click the chart to view options for generating a report.  

You can modify the criteria for the report with selections from the Summarize 
information by and Show lists. You can also specify time ranges. See the page help to 
learn more about the dashboard. 

Best Practice: If you plan to customize the report or chart, create a custom dashboard 
and report to avoid impacting other users. See the Salesforce.com page help to learn 
more. 
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Chapter 9: Chatter 
 

This section contains the following topics: 

Chatter (see page 59) 
Turn Following On or Off (see page 59) 
How to View Different Types of Chatter Information (see page 60) 

 

Chatter 

Chatter lets you communicate with others in your organization and exchange 
information in real time. Using Chatter, you can do the following: 

■ View your information, status updates of people you follow, updates to records you 
follow, and updates to groups in which you are a member. 

■ Create a chatter group that allows members to post updates and communicate with 
each other privately. 

 

■ Add attachments or links to a posting. 

■ Determine whether you want to follow a user or a record that has been enabled for 
Chatter. 

You can modify the Chatter setup. For complete information about using Chatter, see 
the Salesforce.com Help & Training. This documentation is available if you click the 
Setup link to bring up Personal Setup. Then click the Help link. 

 

Turn Following On or Off 

You can follow information about the following CA Clarity Agile or CA Clarity 
Requirements items using Chatter: 

■ Products 

■ Releases 
 

■ Requirements 

■ Features 
 

■ Sources 

■ User stories 
 

■ Tasks 

■ Issues 
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The Following option is enabled by default for items that you create. If you are not the 
creator of an item, the Following option is deactivated. But you can manually activate it. 

 

You can tell if an item is followed by looking at the Following column on the list page.  

Follow these steps: 

1. Open the appropriate list page and locate the specific item in the list. 

2. In the Follow column of the list item, choose one of the following options: 

■ To follow the list item, click the green icon to the left of the word Follow. 

■ To turn off the Following option for the list item, click the icon to the right of 
the word Following. 

 

How to View Different Types of Chatter Information 

Chatter is available for both CA Clarity Agile and CA Clarity Requirements. The Chatter 
information that you view in either of these products pertains only to that product. The 
product supports the following Chatter information types: 

■ View Chatter for all of the items that you follow. (see page 60) 

■ View Chatter activity for an item. (see page 60) 
 

View Chatter for all Items that You Follow 

The Chatter page lists the consolidated activity on all the items that you follow in either 
CA Clarity Agile or CA Clarity Requirements. 

Follow these steps: 

1. Go to the Requirements or Agile menu, depending on the Chatter information you 
want to view. 

 

2. With the menu displayed, select Chatter from the Overview menu. 

The complete list of Chatter activity for the items you follow appears. 
 

View Chatter Activity for an Item 

A Chatter Feed is available from the detail page of an item, such as a requirement or 
user story. The Chatter activity is specific to the selected item. 

Follow these steps: 

1. Open the detail page of an item (for example, a specific requirement in CA Clarity 
Requirements or a specific user story in CA Clarity Agile). 
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2. In the View field, select Chatter Feed. 

Chatter activity for the item appears. 
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Chapter 10: Using CA Clarity Requirements 
with CA Clarity Agile 
 

This section contains the following topics: 

Using CA Clarity Requirements with CA Clarity Agile (see page 63) 
Epics (see page 64) 
Create a Sprint (see page 65) 
Create a Team (see page 66) 
User Stories (see page 67) 
Example: Connect Traditional Requirements to Agile Development (see page 70) 

 

Using CA Clarity Requirements with CA Clarity Agile 

If you are using CA Clarity Agile with CA Clarity Requirements, you can complete the 
following CA Clarity Agile tasks while working in CA Clarity Requirements: 

■ Create an epic (see page 64) 

You can create an epic from the Requirement Detail page, or link an existing CA 
Clarity Agile epic to a requirement. Epics help group requirements into larger 
categories, such as "User Interface" or "Managing a Scrum Team". 

■ Create a sprint (see page 65) 

You can create a sprint from the Release Detail page. When you create a sprint and 
populate the necessary fields in CA Clarity Requirements, the sprint detail opens in 
CA Clarity Agile so that you complete user stories. 

■ Create a team (see page 66) 

You can create a scrum team from the Product Detail page. You can specify key 
information such as the team name, expected velocity, story point scale, and 
meeting details. 

If you create a team in CA Clarity Requirements, you can open CA Clarity Agile and 
go to the Teams list page and find the team. 

■ Create a user story (see page 67) 

From the Requirement Detail page, you can create a user story for that 
requirement. You can also link existing user stories.  

■ Create a task (see page 68) 

You can create tasks for a CA Clarity Agile user story from the User Story Detail 
page. 
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Epics 

You can create an epic and link it to a specific requirement in CA Clarity Requirements. 

The following statements apply to epics created in CA Clarity Requirements: 

■ The epic must be associated with the same product, release, and sprint as the 
requirement.  

■ Epics created in CA Clarity Requirements are included in CA Clarity Agile and can be 
viewed and edited from that product. 

■ Epics can have associated user stories. 
 

The following illustration shows parent and child requirements with their associated 
user stories in the Traceability Matrix. 

Equation 1: Requirements and epics are displayed in parent and child relationships 

 

Requirements and epics are defined by levels to indicate parent-child relationships, so 
that the epic is shown in the same level as its associated requirement. 

You can click the requirement name or the user story name in the Traceability Matrix to 
see details. 

 

Create Epics 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. Click a requirement to open the Requirements Details view. 
 

3. Scroll down to the User Stories and Epics section and click New Epic. 

The New Epic pop-up dialog opens. 
 

4. Complete the requested fields. 
 

5. Save your changes. 

You can also link epics to child requirements by clicking the name of the child 
requirement to open the detail page. Use the same method to link an epic. 
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Link an Epic to a Requirement 

You can link an existing epic from CA Clarity Agile to a requirement. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. Click a requirement to open the Requirements Details view. 

3. Scroll down to the User Stories and Epics section, and click Link User Story/Epic. 

The Link User Story/Epic pop-up dialog opens listing user stories and epics that are 
associated with the current product. 

4. Select an epic. 

5. Save your changes. 

The epic is listed in the list of User Stories and Epics. 

You can also link epics to child requirements by clicking the name of the child 
requirement. Use the same method to link an epic. 

 

Create a Sprint 

You can create a sprint from the Release Details page for a specific release. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Releases. 

2. The release list page appears. 
 

3. Select the release and click Details. 

The Release Details page appears. 

4. In the Sprints section, click New Sprint. 
 

5. Complete the required fields. 

6. Save your changes. 

The Sprint Backlog & Charts page appears.  
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Create a Team 

You can create a scrum team in CA Clarity Requirements for a product. As you create the 
team, the information is shared with CA Clarity Agile and the team appears in the 
product team listings. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Products. 

The products list page appears. 

2. Select the product that you want to create a team for and click Details. 

The Product Details page appears. 

3. In the Teams section, click New Team. 

4. Complete the requested fields. 

5. Save your changes. 
 

Add a Member to a Team 

You can add members to a team from the Product Details page. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Products. 

The products list page appears. 

2. Select the product and click Details. 

The Product Details page appears. 

3. In the Teams section, click the name of the team to display the Team Details page. 

4. In the Team Members section, click New Scrum Team Member. 

The Team Member Edit page appears. 

5. Complete the requested fields. 
 

6. Save your changes. 
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User Stories 

When you create a user story for a requirement in CA Clarity Requirements, the two are 
linked.  

The following statements apply to user stories created in CA Clarity Requirements: 

■ The user story must be associated with the same product, release, and sprint as the 
requirement.  

■ User stories created in CA Clarity Requirements are included in CA Clarity Agile and 
can be viewed and edited from that product. 

 

■ To view requirements and their associated user stories, open the Traceability 
Matrix or the Requirement Hierarchy. 

You can click the requirement name or the user story name in the Traceability Matrix to 
see details. 

 

Create a User Story for a Requirement 

A user story must be associated with the same product, release, and sprint as the 
requirement. Once the user story is created, to complete full information about the user 
story, edit the user story details. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. Click a requirement to open the Requirements Details view. 

The Requirement Details page appears. 

3. In the User Stories section, click New User Story. 
 

4. Complete the requested fields. 
 

5. Save your changes. 
 

Edit User Story Details 

To complete information for a user story in CA Clarity Requirements, open the User 
Story Details page. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. Click a requirement to open the Requirements Details view. 

The Requirement Details page appears. 
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3. In the User Stories section, click Details next to the name of the user story. 

The User Story Details page appears. 

4. Modify the required fields. 
 

5. Save your changes. 
 

Link a User Story to a Requirement 

A requirement can be linked to more than one user story. You can create a user story 
for a requirement or you can link (associate) a requirement with an existing user story. 

 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. Click a requirement to open the Requirements Details view. 
 

3. In the User Stories section, click Link User Story. 
 

4. Select the requirement that you want to link to and click Save. 

After you link an existing user story, you can see whether the user story has 
dependencies in the Flags column. Additionally, you can view and edit the user story 
details. 

 

Create a User Story Task 

A user story is broken down into one or more tasks. Tasks are items of work that one or 
more team members perform during a sprint. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. Click a requirement to open the Requirements Details view. 

3. In the User Stories section, click Details next to the name of the user story. 

The User Story Details page appears. 

4. In the Tasks section, click New Task. 

5. Complete the requested fields. 
 

6. Save your changes. 
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Add a Note to a User Story 

You can add notes to user stories to document information about it. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. Click the title of the requirement you want to work with. 

The detail page appears. 
 

3. In the User Stories section, click Details next to the name of the user story. 

The User Story Details page appears. 
 

 

4. In the Notes & Attachments section, do one of the following: 

■ Click New Note and complete the requested fields. The following fields require 
explanation: 

Private 

Specifies only the creator can view or edit the note. 

■ Click Attach File and browse the required file. 

5. Save your changes. 
 

Link an Issue with a User Story 

You can link an issue that appears in CA Clarity Agile with a user story. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. Click the title of the requirement you want to work with. 

The Requirement Details page appears. 
 

3. In the User Stories section, click Details next to the name of the user story. 

The User Story Details page appears. 
 

4. In the Issues section, click Link to Issue. 

The Link to Issue window appears. 
 

5. Enter the first letter of the issue name to display a list of the issues that are in CA 
Clarity Agile and select the appropriate issue. 

 

6. Save your changes. 
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Add a Comment to a User Story 

You can create comments for the user story to document information related to it. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. Click the title of the requirement you want to work with. 

The Requirement Details page appears. 
 

3. In the User Stories section, click Details next to the name of the user story. 

The User Story Details page appears. 
 

4. In the Comments section, click New Comment. 

5. Enter your comment in the Comment text box. 

6. Save your changes. 
 

Example: Connect Traditional Requirements to Agile 
Development 

Karen Smith is a Forward, Inc. product owner. As release planning is wrapping up, she 
discovers that the new software service she is planning has been assigned to an agile 
development team. The development team has requested the requirements in the form 
of user stories. 

 

In CA Clarity Requirements Karen selects the next release of her product and views the 
requirements included for the release. She selects each requirement individually and 
creates user stories that express the requirement. In a few cases, there is only one user 
story for a requirement, but most requirements spawn several user stories. 

 

The development team is using CA Clarity Agile. When Karen creates a user story, it 
shows up in the backlog for the product, tagged to the correct release in CA Clarity 
Agile. 

 

When Karen completes the user story creation exercise, she returns to the CA Clarity 
Requirements requirements list view. In the View field, she selects Traceability Matrix 
and filters the view to show the product and release she is planning. She can then see 
the traceability from the selected features for the release to the user stories. She can 
study the traceability to help ensure that all requirements for her release have an 
associated user story for the development team. 
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Chapter 11: Using CA Clarity Requirements 
with CA Clarity Ideation 
 

This section contains the following topics: 

About Using CA Clarity Requirements with CA Clarity Ideation (see page 71) 
View Details of an Idea (see page 72) 
Create and Link a Requirement to an Idea (see page 72) 
Link an Existing Requirement to an Idea (see page 72) 
Link a Product to an Idea (see page 73) 
Link a Source to an Idea (see page 73) 

 

About Using CA Clarity Requirements with CA Clarity Ideation 

Ideas are created in a CA Clarity Ideation community and appear in read-only format in 
CA Clarity Requirements. You cannot edit the properties of an idea in CA Clarity 
Requirements. You can link an idea to a product, requirement, or source. 

Ideas displays in the following ways in CA Clarity Requirements: 

■ All ideas entered in CA Clarity Ideation appear in the Inbox list, with the community 
source name in the Type column. 

CA Clarity Ideation - community_name Community  

Displays the name of the CA Clarity Ideation community. 

For example: CA Clarity Ideation - Agile Community 

■ Ideas that are linked to a requirement, product, or source appear on the detail 
pages for the requirement, product, or source.  

You can link products and requirements to ideas in CA Clarity Ideation. Note the 
following rules: 

■ An idea can be linked to multiple products. 

■ A product can be linked to multiple ideas. 

■ An idea can be linked to multiple requirements. 
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View Details of an Idea 

Follow these steps: 

1. Click Requirements, from Overview, click Inbox. 

The list of inbox items appears showing ideas entered in CA Clarity Ideation. 

2. Locate the idea whose details you want to view and click Details. 

The detail page for the idea you selected appears. From this page you can view CA 
Clarity Requirements products, requirements, or sources that are linked to the idea. 
You can also click a link to see the detail page in CA Clarity Ideation. 

 

Create and Link a Requirement to an Idea 

Follow these steps: 

1. Click Requirements, from Overview, click Inbox. 

The list of inbox items appears showing ideas entered in CA Clarity Ideation. 

2. Select the idea in the list that you want to create a requirement for and click New 
Requirement. 

The requirements list page appears. 
 

3. Complete the requested fields. 
 

4. Save your changes. 
 

Link an Existing Requirement to an Idea 

To link an idea to a requirement, both must be linked or associated with the same 
product. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Requirements. 

2. Click a requirement to open the Requirements Details view. 

The detail page appears. 
 

3. In the Inbox Items section, click Link to Inbox Item. 

A list of inbox items that are linked to the requirement's product appears. 
 

4. Select the ideas to link to the requirement and click Add. 
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Link a Product to an Idea 

You can link a product to more than one idea. 

Follow these steps: 

1. Click Requirements, and from Detailed Planning, click Products. 

The products list page appears. 

2. Click Details in the Actions column of the product. 

The detail page appears. 
 

3. In the Inbox Item section, click Link to Inbox Item. 

The list of inbox items available from CA Clarity Ideation appears. 
 

4. Select the ideas to link to the product and click Add. 
 

Link a Source to an Idea 

Follow these steps: 

1. Click Requirements, and from the Business Planning, click Source. 

2. Click Details in the Actions column of the source. 

The Source Details page appears. 
 

3. In the Inbox Items section, click Link to Inbox Item. 

A list of inbox items appears. 
 

4. Select the ideas to link to the source and click Add. 
 

Chapter 12: CA Clarity Requirements Access 
Rights 
 

The following user profiles are available with CA Clarity Requirements: 

Super User 

A person with this profile has administrator privileges to CA Clarity Requirements 
data, but not to the Force.com operating environment. The super user can do any 
of the following tasks using features that are listed on the Administration menu: 

■ Add users 
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■ Configure CA Clarity Requirements setup 

Product Owner 

A person with this profile has the rights to view, create, edit, and delete the 
following regardless of product membership. They also have the rights to 
participate in a product provided they are on the product team.  

■ Release 

■ Features 
 

■ Requirements 

■ Sprint 

■ User Stories 

The product owner cannot create products or add Agile/Requirements users. 
 

User 

A person with this profile can do the following tasks: 

■ Create and manage products, releases, and features 

■ Create and manage requirements 

■ Create and manage sources and personas 
 

If you are using CA Clarity Agile with CA Clarity Requirements, you must be assigned to a 
product to view any CA Clarity Agile page. You can do the following tasks from the Agile 
menu: 

■ Create, edit, and delete themes 
 

■ Create, edit, and manage user stories and tasks 
 

■ Edit a team 

■ Participate in a sprint 
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Appendix A: Glossary 
 

Category 
A category is way to classify a requirement. You define requirement categories for your 
organization specific to your enterprise needs. Examples of categories include: Market 
Requirements, Technical Requirements, Functional Requirements and Nonfunctional 
Requirements. 

 

Competitor 
When you create a product, you can indicate that the product is a competitor product. 
You can store the same detailed information for a competitor product as for a product 
you are developing. You can use the competing product as a source of requirements. 

 

Epic 
An epic acts as a parent container for multiple child user stories that span multiple 
releases and sprints in a product. You can link epics to requirements to provide 
traceability and to help with the planning process. 

 

Feature 
A feature is part of a product. A feature can be independent and standalone, or it can 
work with other parts of a product. 

 

Persona 
A persona can be a person or a composite of many people. The description of a user, 
customer, buyer, or other individual who can cause you to create a requirement. You 
can link requirements to personas and sources to provide traceability and to help with 
the planning process. 

 

Product 

Something of value a company produces for sale or internal company use. A product can 
be merchandise or wares, software, a building project, or any other consumable. 
Products also represent services, applications, or systems in an IT environment. 
 

 

Product Owner 
The scrum team member that is listed as the product owner in the properties of a 
product.  
The product owner has privileges over all objects that are associated with the product, 
such a requirements, releases, sprints, and backlog items. The product owner does not 
need to be a scrum team member to work with user stories associated with the product. 

 

Release 
A release is similar to a project, an effort that ends with the delivery of value. The 
release usually entails a number of features and requirements. 
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Requirement 
A requirement is a documented specification that describes a particular product or 
service and what it can be or do. A statement that defines a necessary attribute, 
capability, characteristic, or quality of a product or service so that it provides value to a 
user. 

 

Source 
A source can be a company or organization. You can collect information about sources 
and include contact information and other market information. A source can be linked 
to a requirement to provide traceability and context. 

 

Traceability 
The ability to trace a requirement from its origin to the lowest levels of implementation, 
typically a test case, or work item. 

 

User Story 
A user story is a way to define requirements in CA Clarity Agile. If these products are 
used together, a requirement in CA Clarity Requirements can be linked to its associated 
user story in CA Clarity Agile. 
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